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1.1 Canvas 

 

The canvas is a container object for several types of objects. In the canvas we can place: 

formulas, graphs, images, comments, text boxes, bookmarks, tables, data objects, shapes, arrows, 

lines and trees. To insert a canvas object, press the Canvas icon and click on any unused part of the 

document in order to place the canvas. You will have to place a canvas before placing a graph, the 

canvas size must also be big enough to accommodate a graph. 

 

 

Picture 1: Canvas 

 

Picture 2: Canvas Properties – border 

 

Note: 

Settings that we have described in this section, all properties that can be set from Canvas properties 

context menu option, refers only to the selected canvas. 

 

 

 

 

A Right mouse click will open the menu shown in Picture , 

from this menu you can Collapse Canvas and open canvas 

Properties. 

 

 

The Properties option will open the Canvas Properties 

window which refers to the current canvas only. From the 

Properties window we can set a grid and a snap (as 

described in Layout tab icon Canvas Properties,Error! 

Reference source not found.). 

By default the canvas borders are off. You can choose 

whether the borders are on or off, set their colour, 

thickness, style and rounding all from the Border tab ( 

Picture 2). When you select the canvas, its border colour is 

blue. 

  

The canvas background colour can be set from the 

Background tab. 

You can resize the canvas if you adjust the indents using the 

ruler when the cursor is in the canvas. 

 



1.2 Matrices 

 

Matrices are used as a store of data for a graph to plot, therefore you must create a matrix 

and insert data if you want to plot a graph. There are two ways to create a matrix in MatDeck. 

Matrices with a desirable size are created empty and then you insert data in them afterwards.  

You can use the Insert Matrix option from Maths tab, where you can choose the size of the matrix. 

To create a matrix 2x3 and insert data into it. Choose the matrix size from the Insert Matrix 

option, as shown on Picture , and an empty matrix will appear in the canvas 

        

Picture 3: Insert matrix 

If you wanted to store this matrix inside a variable, you should first create variable a with the 

command a := and repeat the above steps to create a matrix. You can insert data into the matrix 

simply by placing the cursor inside an empty node of the matrix and typing the desired data. 

You can process all the data in a matrix using a single arithmetic operator of function 

   

In MatDeck there is a group of functions called Matrix and Vector in which you can find a whole 

range of functions for data manipulation on matrices. For example,  

    

There are also several functions that will perform arithmetic operations with matrices, element-by-

element rather than using matrix rules, and these are the following: mul for element-by-element 

multiplication, div for element-by-element division. For example, 

    

 



1.3 Graph 

 

We can use graph objects when we want to plot 2D graphs. This object can only be inserted 

in a canvas. There are two ways of inserting a graph object in the document: press the Graph icon 

and click in the document, a canvas will be placed and inside it will be the graph object; if we already 

have a canvas in our document and we want to insert a graph in it, we press the Graph icon and click 

in the canvas on the position where we want to place it.  

To plot a graph you have to define a variable and store data in it. Only data stored in a matrix can be 

plotted, where the first column of a matrix represents the x-axis data and the second column is the 

y-axis data in the graph. The minimal number of nodes which can be plotted on a graph is two, so 

the minimal matrix size for a plot is 2x2. There are several functions that place data in a matrix, and 

thus prepare them to be drawn in the graph. Those are: curve2d, complexcurve2dre, 

complexcurve2dimg, curve2d_param, curve2d_param_re, curve2d_param_im. 

 

 

Picture 4: Graph object 

 

 

 

Picture 5: Graph dropdown menu 

 

 

This is what a default graph will look like once it has been 

inserted into the document (Picture ). Use the surrounding 

blue boxes to make the graph bigger or smaller. 

The graph consists of Title, Axes, Drawing area and 

Legend. If you place the cursor on the title or any of the 

axes and double left click on them, edit mode will open so 

you could set the Title or rename the Axes. 

Legend is displayed in the top right corner of the Drawing 

area and contains all variables that are added on the 

selected graph. 

If you right click on the Drawing area of the graph a 

dropdown menu shown on Picture  will appear.  

With Copy As Image and Save As Image, you can copy and 

save the graphs as images. You can choose between three 

different levels of picture quality. 

The Add Variable option will show a list of all variables 

created in the current document from which you could 

choose what variable to plot. 

The Remove Variable option will show a list of variables 

that are already plotted on the current graph, from this 

you can choose what variable you want to remove from 

the graph. Use the Remove All Variables option to remove 

all the plots from graph.  

The Auto range option will reload the graph and adapt the 

scope of the axes to the data that is stored in our 

variables. 

Curve Manager and Properties open a new options 

windows, Graph properties and Display properties have a 

detailed description in Graph Tab section (Picture  and 

Picture ). 

 



1.3.1 Example: Graph 

 

Create a graph of the trigonometric functions sine and cosine on a [-2π, 2π] segment and 

place them on the same graph. 

Solution: 

Create a new document by pressing New icon  , press the Maths icon  and select a 

place on the document where you wish to place it. A new canvas object will appear with a Maths 

object inside it. Now create the new variable a:=curve2d, this code will create the new variable a 

and store the results of the function curve2d in it.  

The function curve2d will always be used when we want to draw a graph, it is a function that creates 

a matrix of two columns and the number of rows can be determined in the fourth argument. The 

first argument is the function that we want to draw with preferred symbols or values as arguments, 

the second and third are numerical intervals of values that correspond to the symbol which appears 

in first argument function. The fourth argument is the number of samples. In the first empty node 

type sin to create new sine function , then type symbol x as its argument. In the second node 

type -2*cpi (this is a standard way of inserting constants π in to the document, every constant has a 

character c in front of it), in the next node type 2*cpi and in the last node type 100 for example. 

From the Insert tab select the Graph icon  and click a place on the canvas where you want to 

place it, a new graph object will appear. Right click the graph and press Add variable option from the 

content menu, now choose the variable a, that we created earlier. A sine function graph will appear. 

Let us create another variable b:=curve2d. In the first empty node, type cos to create new cosine 

function  and type the symbol x as its argument. In the second node type -2*cpi, in the next 

node type 2*cpi and in the last node type 100. Right click the graph and press Add variable option 

from the content menu, now choose the variable b, that we created earlier. A cosine function graph 

will appear. 

 



 

 

1.4 Graph tab 
 

 

Picture 6: Graph tab 

 

This tab refers to work done with 2D graphs and their settings. Options from this tab can 

only be used if a graph object is inserted in the document and already selected. The option Graph 

from this tab is same as the Graph option from the Place tab, when clicked and placed on a 

document, a new canvas will appear with a graph inside of it. 

 

 

1.5 Data table 

 

 

 

Picture 7: Data table 

 

 

When you press the Data table icon, the window 

shown on Picture  will open. From the dropdown 

menu on top of the window, select a variable and 

the data you would like to see. The menu list will 

contain all variables that are plotted on the 

selected graph. 

The data set is displayed in a table with two 

columns, the first one represents data for x axis of 

the graph and second column is y axis data. 



1.6 Graph 

 

This option is the same as the Graph option from the insert tab, which is described in detail 

in section 1.3  .  

 

1.7 Titles 

 

 

Picture 8: Titles table 

 

 

 

1.8 Curves 

  

 

Picture 9: Curve table 

 

When you press the Curves icon, the window from Picture  will open. From this window we 

can see and manage all the curves plotted in a graph. Every cell of the table is editable (double click, 

drop down menu, arrow change,…) and you can change: whether curves will be displayed, change 

name, title, colour, amplifier, multiplier, offset, phase, style, origin of the curve. Amplifier, offset, 

phase and multiplier can be set from the window by choosing which parameters you would like to 

change, setting up the value and pressing apply. Also there is a reset button to return values to 

default state. 

 

The Titles icon will create a table containing all 

the graph variables from the moment of 

creation. So if you make any change in the 

graph (add/remove variable) you will have to 

create new a table because it won’t 

automatically update any changes. 



1.9 Graph properties 

 

 

Picture 10: Display - Axis tab 

 

 

Picture 11: Display - Numeration tab 

 

 

Picture 12: Display - Title tab 

 

Picture 13: Display - Background tab 

 

Picture 14: Display - Advanced tab 

Pressing the Graph Properties icon will open a 

window, as shown on Picture , the same can also be 

done with a right click to open the content menu 

and then selecting the option Graph Properties; 

from which you can configure graph axis and 

numeration, graph title, background colour, 

margins, perspective distance, refresh interval, etc. 

As stated before, all these options refer only to the 

current graph and they are not global settings. 

From the Axis tab(Picture ) you can choose if axes 

are going to be displayed or not, change their 

names, width, line style, colour and font. 

Also you can mark the centre of the graph and 

choose its axis colour. 

From the Numeration tab (Picture )you can choose if 

axes numeration are going to be displayed or not, 

set their font, colour, will it be calculated 

automatically or manually (if you choose manually 

you will have to set a number of decimal places for 

each axis) and set exponential numeration bases for 

each axis. 

From the Title tab(Picture ) you can set the title, 

choose if it will be displayed or not, set the font and 

colour. You can also choose to show the Legend on 

the graph or not. If you plot a large amount of 

curves, the best practice is to not display a legend 

but to use a Titles table (section 1.7) instead. 

From the Background tab(Picture ) you can change 

the background colour of the graph. 

From the Advanced tab(Picture ) you can change 

margins, refresh intervals and distance for 3D 

perspective. You can also change axis bases from 

decimal to logarithmic for both axis or just for one of 

them. There is also the option to Turn Auto Scale 

On, and when it’s turned off you can auto scale the 

graph with Auto Range from right clicking content 

menu. The Turn Antialiasing On option will remove 

“jaggies” and the staircase effect from plotted 

curves when it is on. 



1.10 Quadrant 

 

 

Picture 15: Quadrant window 

 

 

1.11 Range 

 

 

Picture 16: Range window 

 

 

 

 

 

 

 

Press the Quadrant icon and the window shown in 

Picture  will open. This option allows you to pick 

which quadrants of graph you wish to be seen.  

 

From this window you can change the range of a 

selected graph to any of the present values or you can 

click custom to use your own. To use this option, 

press the Range icon and the window shown in 

Picture  will open. 

The four fields, in the bottom of the picture on the 

left, are only editable if the custom option is selected.  



 

1.12 Curve manager 

 

 

To change the curve properties, press the Curve Manager icon and the window shown in 

Picture  will open. This is the same as from the right click content menu option; Curve Manager. 

There is a tab for each curve in this window, you can add or remove curves using the Add Curve and 

Remove Curve buttons at the top of it. For every curve, the setting is dependent on their features:  

Name field: depending on the source of data for the curve, this field can be editable or not, if the 

source is Device channel name, the field is editable, if the source is Document variable or Database 

table this field isn’t editable and the name of the curve is the same as in the variable or database;  

 

Picture 17: Graph Properties 

If Device channel is selected, the Channels group of settings on the right hand side of the 

window will become editable. You can set the curve from the Multiply and Offset boxes. From the 

Channel Table tab you can establish a channel connection which will be the source of data for the 

curve. Mark the Select Channel Server, insert the Server IP address and Server port, press the 

Connect button and the connection will appear in table below. From the Settings tab you can set 

which columns will be visible in the channel connection table. To finish the process of creating a 

channel as a source of curve data, mark the connection from the table and press Select button.  

If Document variable is selected as the curve source, the Available variables drop down 

menu will appear; from this you can choose which variable is the source of curve data. The drop 

down menu will contain a list of all variables created in the current document. The option for the 

channel group will not be editable in this case.  

If Database table was selected as the curve source, the Database tables drop down menu 

will appear; from this you can choose which curves from the database will be displayed on the 

graph. The Database tables drop down menu contains all the options where we established a 

connection to the database from the Data tab of software . That selected database contains the data 

for at least one of the curves.  

 

For every curve, you can set a colour, font, style 

and thickness. You can also choose to mark on 

the curve: source Data point and the way they 

will be displayed (rectangles, circles, x marks); 

interpolated Inner points and the way they will be 

displayed (rectangles, circles, x marks). 

Curve source contains the following options: 

Device channel, Document variable and Database 

table. 



1.13 Grid  

 

 

Picture 18: Graph grid properties 

 

1.14 Toolbox 

 

 

Picture 19: Graph toolbox window 

 

 

 

1.15 Perspective 

 

 

Picture 20: Perspective view 

 

From the window shown in Picture , you can change 

the graph grid properties: you can show or hide the 

grid, set line width, style, colour, make the grid 

resizable, choose its size, show or hide notches 

along the axis. You can also show or hide 

subdivision, choose its size by selecting how many 

parts you would like to divide the grid into, set 

subdivision line width, style and colour. 

From the Toolbox option, the window shown in 

Picture  will open. You can change multipliers for 

each of the axes (their default state is 1), and that 

change will “shrink” or “stretch” the curve 

depending on your input. This option refers to all 

curves on graph. 

To use the Auto Roll option, select a range by 

inserting the start and finish value for the x axis, 

move the blue slider to select a speed of roll. After 

you have set all parameters, press the Start button. 

The Perspective option will put every curve displayed 

on the graph in a different plane and place them 

according to the imaginary axis displayed as the 

dashed line in Picture . 



 

1.16 Interpolation 

 

 

 

Picture 21: Interpolation 

1.17 Regression 

 

 

Picture 22: Regression 

 

 

 

 

 

 

To use interpolations, press the Interpolation icon 

and the window shown in Picture  will open. These 

settings refer only to the currently selected graph.  

If the number of nodes in the source data for the 

curve is too small and you want to make the curve 

line more round because of its sharp edges, select 

the interpolation method you prefer, set the number 

of interpolation points and press the Apply button. 

The number of interpolation points is a number in 

the range of 1-99 and represents the number of 

points that will be placed between two source nodes. 

To use regressions, press the Regression icon and 

the window shown in Picture  will open. These 

settings refer only to the currently selected graph. 

Use this option when you want to find a function 

that best fits the source data. 

The number of regression points is a number in the 

range of 1-99 and represents the number of points 

that will be placed between two source nodes. 



1.18 Examples 

1.18.1 Example: Graph tab 

 

Sketch the graph of f(x) = (x - 1)3+ 1 on interval [-1, 3] with the number of samples set to 20. 

Create a Data table for this function, interpolate function curve with Hermit spline interpolation, 

display graph only in first quadrant, the “shrink” function will double its size with respect to x axis, 

display input data points with blue circles and colour graph curve in orange. 

Solution: 

Create a new document by pressing the New icon  , press Maths icon , select a place on the 

document where you want to place it, a new canvas object will appear with a Maths object inside it. 

Create a variable with code a:=curve2d and a new variable with function inside it will appear

. In the first argument node type (x-1), hold Shift and type 6, that will create 

a power function node  and then type -1 at the end. In the second argument node -1, in the 

third argument node type 3 and in the fourth one type 20. 

  

From the Place tab select Graph icon , select a place on the canvas where you want to place it; a 

new graph object will appear. From the right mouse click content menu select Add variable option 

and choose variable a we created earlier, a function graph will then appear. 

Select the graph object by clicking on it once and pressing the Interpolation icon . Tick the 

Hermit spline, set Number of interpolation points to 15, press apply and close this window. Notice 

that the graph curve is now much more rounded than before.  

Press Curve Manager icon , press the red quadrant  and the Select colour window 

will appear, set colour to orange and press OK. Tick on Data point’s option, select the Circle from the 

drop down menu and set colour to blue . With the previous settings we 

change the graph colour to orange and the draw input data points with blue circles. 

Press Toolbox icon , and for the x Axis Multiplier set the value to 2.0. That will double the size of 

the graph with respect to the x axis.  



Press Quadrant icon , then tick option 1, press apply and close this window. After this setting 

you should only see the first quadrant of the graph.  

Now press Titles icon , a table will appear in the canvas. Place the cursor in the title column and 

type f(x), now place the cursor in the top left corner of  the table (cursor arrow will change to black 

arrow), open Home tab and from the Align icon drop down menu   select Align Center to align 

all table items. 

Place the cursor above the Title of the graph object and double click on title text. A text field will 

open, type f(x) and press the Enter key from the keyboard. 

If you have done all the tasks from this example, the graph at the end will look like the graph on 

Picture 1. 

 

Picture 1: Graph tab example 

 

1.18.2 Example: Import from database 

 

Import data we exported in example Error! Reference source not found. and draw 2D graph 

with them. 

 

Solution: 

 Create a new document by pressing the New icon  , press Maths icon , select a place 

on the document where you want to place it. A new canvas object will appear with a Math object 



inside it. Create the variable with code b:=0, this is the variable in which we are going to import data 

from the database file.  

Press the DB Manager icon  and then press the Select database button. A new window will 

open, select the Desktop of your computer, selected the base.db file and press Open button. Press 

the  button and now the connection to the database is established. The connect 

button now has changed to  button. Press Close to exit this window. 

Press the Import icon   then select a place on the canvas where you want to place it, a new 

Database import object will appear . Place the cursor above this object, using the 

right mouse click content menu choose Properties and the Import Variable From Database window 

will open. Press Select database button and from the new window that has just opened choose 

base.db file from your Desktop. Press Add Variable button and a new tab will appear. There are two 

drop down menus, Read From Table with 

variable a selected (this is the variable in the 

database where we have stored our data) and 

Write To Variable with variable b selected (this 

is the only variable in our current document, 

you can always create another variable and 

choose it for data import). Press Close button 

to exit this window. 

The database import data object will now looks like 

this  meaning that we have 

imported data from the database to variable b. Now 

we shall draw the graph with this data. 

From the Place tab select Graph icon then select a 

place on the canvas where you want to place it; a new 

graph object will appear. Using the right mouse button 

click content menu, select Add variable option and 

choose variable b. A function graph will appear. 

As you can see this is the graph of the sine function on 

interval [-2, 2]. The data we have exported earlier to 

the database were successfully imported and shown 

on the 2D graph. 

1.18.3 Example: Import from excel 

Import data we exported in example Error! Reference source not found. and draw 2D graph 

with them. 

Solution: 



 Create a new document by pressing the New icon   and then press the Maths icon , 

select a place on the document where you want to place it, a new canvas object will appear with a 

Maths object inside it. Create a variable with code b:=0, this is the variable in which we are going to 

import data from the excel file export.xlsx. PresstheImport icon , select a place on the canvas 

where you want to place it, a new Excel export object will appear . Place the cursor 

above this object, right click with your mouse on the content menu and choose Properties and an 

ExcelReader Object window will open.   

Press the Browse button and from the new windows that you have just opened choose export.xlsx 

file from your Desktop (file where data was exported). In the Sheets field, choose the excel sheet 

where your data is saved, the Variable field will automatically display variable b (because it is the 

only variable in current document). If there is no variable in the document or you simply want to 

import data in a document, press Add New Variable button, we left variable b as an import location. 

In the Start Cell field, type the excel cell position as a starting cell from which data will be imported 

(we inserted A1 in this field), in the End Cell field. Type the excel cell position as an ending cell from 

which the data will be imported and press the Add button. In the table of imports there will be a 

new row with the variable b that we have just chose to import data to. Press the Close button to exit 

this window.  

After the closing of the Excel Reader Object window, the Excel import object will look like this

meaning that we have imported data from the excel file to variable b. Now we 

shall draw a graph with this data. 

From the Place tab select the Graph icon , click 

the place on the canvas where you want to place it, 

a new graph object will appear. Right click on the 

content menu and select the Add variable option 

and choose variable b. A function graph will appear. 

 

 

 

 

 

 

 

 



1.18.4 Example: Export and Import to channel 

1.18.4.1 Example: Export to channel 

 

Export values of sine function on interval [-2, 2] to channel. 

Solution: 

Create a new document by pressing the New icon  , press the Math icon , select a 

place on the document where you want to place it, a new canvas object will appear with a Maths 

object inside it. Create a variable with the code a:=curve2danda new variable with functions inside it 

will appear .  For function first argument type sin and insert the symbol x 

inthesine function. For the second argument type -2, in the third argument type 2 and in the fourth 

type 30. 

 

Press the Export icon , select a place on the canvas where you want to place it, a new 

Channel export object will appear . Place the cursor above this object, using the 

right click select the content menu and choose Properties and Export Variable To Channel window 

will open. 

In the document Variables menu, variable a is selected as the only variable in this document and all 

we have to do is to press the Add button. Variable a will appear in the list under, press Close to exit 

this window. The channel export data object will now looks like this  meaning that 

we have  exported data from variable a to channel. 

Now we have opened the channel from which we are sending the data via variable a as a matrix with 

two rows, in the first row we have placed data for the x axis and in the second, y axis data. 

At the end we will save the file by pressing the Save icon  from the File tab, from the Save As 

window choose where you want to save the file (we placed it on Desktop), type channel in the File 

name field and press the Save button. 

 

1.18.4.2 Example: Import to channel 

 

Import data we exported in example 1.18.4 and draw 2D graph with them. 



Solution: 

 Create a new document by pressing the New icon  and then press the Math icon , 

select a place on the document where you want to place it, a new canvas object will appear with a 

maths object inside it. Create a variable with the code b:=0, this is the variable in which we are going 

to import data from the channel that we have created in example 1.18.4.  

Before we continue with data importing, we have to open a file in which we can export data. This is 

required because the channels transfer data through TCP protocol, meaning that you have to open a 

channel (we did this in “chanell.mdd” file) and keep it open until data transfer is finished.  

Press the Import icon  and select a place on the canvas where you want to place it, a new 

Channel export object will appear . Place the cursor above this object, from the right 

mouse click content menu and chose Properties and the Import Variable from Channel window will 

open. Press the Add Variable button and a new tab will appear in the channel table. Select a row in 

the table (this is the only row in the table which presents the channel that we have opened in 

“chanell.mdd” file), in the Write To Table drop down menu, select the variable b (variable in which 

we are going to store data) and press the Select button.  

After the closing of the Import Variable From Channel window, the channel import object will look 

like this meaning that we have imported data from channel to variable b. Now we 

shall draw a graph with this data. 

From the Place tab select the Graph icon and select a place on the canvas where you want to 

place it, a new graph object will appear. From the right mouse click content menu and select the Add 

variable option and choose variable b. A function graph will appear. 

As you can see, this is a graph of the sine function on the 

intervals [-2, 2].The data we have exported earlier 

through the channel was successfully imported and 

shown on a 2D graph. 

 

 

 


